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1.  Getting Started With the Bid Express Service 

By the end of this section, you will be able to: 

 Use the Student Guide 

 Understand the Bid Express Service 

 Subscribe to the Bid Express Service 

 Navigate the Bid Express Home Page 

 View the Agency Home Page 

 View the Lettings Tab 

 View a Contract 

 Perform a Search 

 Access Help, FAQs, and Customer Support 
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Using the Bid Express Service Training Manual 

This training manual is divided into sections called learning modules.  Each learning 
module consists of: 

Objectives 

Multiple Topics 

Exercises 

Review 

Each section begins with the objectives for the module.  The module is divided into 
topics roughly corresponding to the objectives of the module.  Each topic has a short 
description of the Bid Express service and the AASHTOWare Project Expedite Bid 
and Expedite Bid software functions, one or more general procedures about how to 
perform an action on the Bid Express website or in the Expedite Bid software, and an 
exercise for the topic.  Exercises are easy to spot on each page.  They are identified by the 
arrow graphic illustrated below and are numbered sequentially.   

 Note:  Both Project Expedite Bid software and Expedite Bid software will 
be referred to as Expedite Bid throughout this document. 

 

Figure 1-1.  Exercise Arrow 

Each module ends with a review.  The review summarizes the main points and all of the 
Bid Express services or the Expedite Bid software functionality covered in the module.  
The review pages may serve as a work aid for use back at the office when you are trying 
to reconstruct what you did in class. 

When implementing the Bid Express service, each participating agency configured the 
terminology on its Bid Express agency page to match the terminology and business 
processes of the agency.  Therefore, the terminology used in this training manual may not 
match the terminology seen on the agency’s website.  For example, some agencies have 
changed the words “Letting” to “Bid Opening” and “Contract” to “Proposal.”  
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The Bid Express Service Training Manual is only one of many sources 
of documentation regarding the Bid Express software and the Expedite 
Bid software.  Additional resources are available on the Bid Express 
website and include the following: 

 Bid Express Online help 

 FAQs on www.bidx.com 

 Bid Express training videos 

 The Expedite Bid User’s Guide 

 Expedite Bid Online help  

 Agency-specific documentation
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Understanding the Bid Express Service 

The Bid Express service is a secure information service that allows subscribers to submit 
bids to participating agencies directly over the Internet and provides access to a database 
of historical bid data, proposal information, and bid letting schedules. 

The Bid Express service saves the time needed for preparing bids on paper and the travel 
time and expense involved in attending lettings and submitting bids in person.   

Understanding the Bid Express Basic Service 

Basic Service allows you to view and download bid information from all agencies using 
the Bid Express service.  A search function allows you to quickly find information.  The 
Bid Express service also provides a complete schedule of items for each contract and the 
eligible bidders and plan holders lists.  A subcontractor quote form makes it easy to work 
and communicate with your subcontractors.  Select the items you want to sub-out and 
print the form with just a few clicks.  

When you subscribe to the Basic Service, you’ll also gain access to the Expedite Bid 
application that allows you to prepare your bids electronically.  With the Expedite 
software, you just need to enter unit prices because the quantities come across 
automatically and the computation is done for you.  The Expedite software has built-in 
error checking functions that make your bids virtually error-free.  With Basic Service, 
you can save your bid to a storage media, such as a CD or flash drive, or print it for 
submission 

Understanding the Bid Express Internet Bidding Service 

When your bid is prepared in the Expedite software, you can use the Bid Express Internet 
Bidding service to submit it over the Internet.  This convenient service means that you no 
longer need to travel to submit bids; no more time away from the office, miles of travel or 
expensive hotel stays just to deliver bids.  When you use Internet Bidding Service, your 
bid is encrypted, signed by your unique Digital ID, and held in a lockbox until the bid 
opening by the agency.  Your Digital ID, available through the Bid Express service, is 
considered your legal signature and your unique identifier.  You can withdraw or replace 
your bid up to the last minute – making it easy to accommodate last minute price 
changes.  The Bid Express Internet Bidding service also has additional error checking 
features to help you submit complete and accurate bids.  Redundant power sources, file 
back-ups and duplicate hardware set-ups help ensure that your bid is secure.  The Bid 
Express service uses the latest digital signature and encryption technology.  The system is 
built, maintained, and constantly monitored to ensure the reliability you would expect for 
this critical service.  
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The service also conducts online verification of bid bonds through surety agencies.  With 
this feature, you no longer have to worry about getting a paper bid bond.  You can obtain 
a bid bond verification code from your surety agency.  When preparing your bid in the 
Expedite software, enter the surety code with your bid submission.  The code is 
embedded in the bid and backed by a participating surety bond processing agency.  This 
feature means less paper and less hassle in meeting the bid bond requirement. 

 

Figure 1-2. Internet Bidding Diagram 
 

For additional descriptions of all the services offered on the Bid Express 
web page, refer to the bidding services area on www.bidx.com.  

The Bid Express Subscriber’s Training Manual’s primary focus is for 
users to understand the function of Bid Express and to submit bids via 
the Internet.  

  Exercise 1-1 

In the following exercise, you will navigate to the Bid Express website.  

1. Go to http://www.bidx.com.  
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Subscribing to the Bid Express Service 

To subscribe to the Bid Express service, go to the homepage at www.bidx.com.  Click 
Order (located at the top of the menu) and then Subscribe Now!  We recommend that 
before signing up, you view the Bid Express service and fee schedule by clicking Order 
from the homepage and then Fee Schedule.  Viewing the fee schedule and services page 
will help you determine the type of services to which you would like to subscribe.  

To request an account with the Bid Express service, you must enter a valid email address, 
enter a password, verify the password, select the agency you were referred by, and agree 
to the Terms and Conditions of the Bid Express Service Subscriber Agreement.  Click 
Submit when done.  The Bid Express service sends a confirmation email to the address 
provided.  Navigate to your email account and locate the email.  Click the link found in 
the email and enter your account password to activate the account.   

Once the account is active, it will allow you to subscribe to services.  Select the services 
you would like to have (please remember the Internet bidding service is applied with the 
creation of a digital ID).  Enter your company name, contact, address, and credit card 
information.  Select a security question and provide an answer.  Click Save. You should 
then receive an email welcoming you to the Bid Express service and another email from 
billing containing the receipt of payment for the subscription.   

Subscription fees are billed in advance on a monthly basis and are not prorated. Monthly 
payments may only be made by major credit cards (Visa, MasterCard, American Express 
or Discover).   
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Figure 1-3.  Subscribing to the Bid Express Service 
 

To submit bids via the Internet, you must have both the Bid Express 
service account and a digital ID.    

Some email systems automatically send the Bid Express welcome email 
to the Junk or Spam folder.  Be sure to check these folders for the email 
containing the Bid Express service login ID and password.  

  Exercise 1-2 

In the following exercise, you will subscribe to the Bid Express service.  

1. Go to http://www.bidx.com.  

2. Select the Order menu and choose Fee Schedule.  

3. Review the available services and associated fees.  

4. Select the Order menu and choose Subscribe Now!  

5. Click the links for the Subscriber Agreement and Acceptable Use Policy and 
review each document. 

6. Enter a valid email address, password, select the referring agency, and agree 
to the terms and condition of the Bid Express Subscriber Agreement and 
Acceptable Use Policy. Click Submit. 



1-8 Getting Started With the Bid Express Services 

7. Locate the email sent to the email address entered and click on the link in the 
email.  Enter the password to activate the account.  

8. Complete the Bid Express Service Form.  

9. Click the Save button.  

10. The information entered is saved and you are then automatically logged in to 
the site.  
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Navigating the Bid Express Home Page 

The Bid Express service is designed for you to view proposal and bid files, as well as to 
download those files to your computer.  Although each agency has different workflow 
and business rules, there are many common functions that apply to all participating 
agencies. 

Viewing the Bid Express Website 

The Bid Express Service home page is divided into sections for easier navigation. There 
are five main menus in the top portion of the home page.  

Bidding Services This menu provides descriptions of the different bidding 
services offered by Bidx.com. 

Order This menu provides a link for ordering a Bid Express 
account, a Fee Schedule, and contact information for 
Bidx.com and agencies using the Bid Express service. 

Policies This menu provides policy information such as the 
Subscriber Agreement and also provides links to policy 
statements for Digital IDs and Bid Bond partners. 

News This menu provides links to various news articles regarding 
electronic bidding. 

Questions/Help This menu provides a list of Frequently Asked Questions 
(FAQ). 

You can select an agency to view the agency specific website. However, you must be 
logged into the Bid Express service with your ID and password to be able to view and 
download files.  

Logging Into the Bid Express Website 

Before you can use the Bid Express service, you must log in.  Enter the email address you 
entered when you registered for the Bid Express service in the Email field on the Bid 
Express home page and press the Tab key.  Enter your password in the password field 
and click the Log In button.  This lets the Bid Express website recognize you as a valid 
user of its services.  Your password is case-sensitive, meaning it must be typed the exact 
same way each time.   
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Without a Bid Express account, users may view limited amounts of 
agency specific information but will not be allowed to download 
proposal information.   

  Exercise 1-3 

In the following exercise, you will log in to the Bid Express website.  

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the password field, type your password.  

4. Click the Log In button.  



Bid Express Training Manual 1-11 

Viewing the Agency Home Page 

The Agency's home page is the first one you see after you select the agency on the Bid 
Express home page.  The title bar of the Agency’s page displays the name of the agency 
and the agency’s current time.  The browser must be refreshed to keep the time current. 

The Agency’s home page is usually divided into three sections.  Each section is agency 
specific and may not be used by all agencies. The first section displays any messages or 
information created for the contractors by the agency.  The second section, What's New, 
lists any new information uploaded by the agency in the last 30 days for any of the 
lettings.  The third section is called Downloads and it is located on the top right side of 
the page. This section allows you to download the Expedite Bid Software. Expedite Bid 
software helps a subscriber with Internet bidding.  Agencies can post proposals and 
amendments as Expedite Bid files to the Bid Express website.  Click the Expedite Bid 
link to download Expedite for use.  Downloading the software is free but there are costs 
involved with using digital IDs. 

 

Figure 1-4.  Agency Home Page 
 

The information posted on the What's New section is anything that the 
agency uploaded to the site in the last thirty days.  This may include 
amendments as well as new proposal information. 
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  Exercise 1-4 

In the following exercise, you will navigate to an agency’s home page.  

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. In the Select an Agency drop-down list, click the expand arrow and click the 
desired agency.  

6. Click the Go button.  
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Navigating the My Bidx Page 

Once successfully logged into the Bid Express web pages, you will automatically be 
routed to the last page you were working previously on the site (if this is the first time 
login in you will remain on the Home page until you select an agency). Most pages in the 
Bid Express service have icons to help you manage your account.   

At the top right corner of the page are the My Bidx icon, where you can reset your 
account preferences and billing information, and the Messages icon, where you can 
manage messages from your bidding agencies.  The Help icon takes you to the online 
help for the Bid Express page you are viewing.  

The MyBidx Icon 

The MyBidx icon is located at the top right corner of every page you navigate to on the 
site.  The My Bidx page is divided into sections: Account Settings, Account Services, 
Billing Information, and SBN. Click on the My Bidx icon. 

Account Settings 

From the account settings section of the My Bidx page you will be able to change your 
Bid Express email address, password, and contact information. 

 Email – Allows you to change your email address. 

 Password – Allows you to change your password.  Please remember this 
password must be at least eight characters in length, it must contain one 
capital letter, a numeric digit, and a special character. 

 Contact Information - You can change the account contact information. The 
contact information section is available to other Bid Express users if you 
choose to publish your information. 

 Challenge Question – Allows you to change the challenge questions used if 
you forget your password. 

Account Services 

The account services section allows you to manage your Bid Express account, create a 
digital ID and view billing information.   

 Bid Express services – Allows you to subscribe and unsubscribe to Bid 
Express website features. 
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 Digital IDs – Allows you to apply for a digital ID, needed for internet 
bidding, or check the status of an ID already created. 

 Cancel my Bid Express account – Allows you to cancel your Bid Express 
account. Canceling an account also cancels all associated features and 
digital IDs. 

Billing Information 

The billing information section allows you to update your billing information as needed. 

 Credit Card Information – Allows you to update your credit card 
information. 

 Billing Address – Allows you to update your billing address. 

SBN 

The SBN section is used to set up your Bid Express Small Business Network preferences. 

 DBE – Allows you to set if you are a disadvantaged business enterprise 

 SBN Work Types – Allows you to select the work types for the Bid Express 
SBN notification. 

Additional Links 

The links at the bottom of the page provide you with additional resources for using the 
Bid Express service. 

 Contact – provides you with a list of contacts for all participating agencies 
as well as the contact information for the Bid Express service. 

 Training Center – provides you with the training manual for how to use the 
website. 

 Privacy Policy – displays the Bid Express privacy policy. 

 Product Updates – Lists updates for the product. 
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Figure 1-5.  My Bidx Page 

Accessing the Training Center 

The Training Center for Bid Express subscribers can be accessed by clicking the training 
center link at the bottom of every page on the site.  The training center currently contains 
the User Guide for the website. 

  Exercise 1-5 

In the following exercise, you will change your password.  

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. Click the My Bidx icon in the right corner.  

6. Click the Password link in the Account Settings section.  

7. Enter your current password in the Current password field.  

8. In the New Password field, type the desired new password. It must be at least 
eight characters long and contain at least one number and one letter and a 
special character. 

9. In the Re-type New Password field, type the new password.   

10. Click the Save button. 
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Viewing the Lettings Tab 

The Lettings tab displays every letting date since the Bid Express service has been in 
production in that agency.  It also shows the local time for the agency.  The browser must 
be refreshed to keep the current time.  Each date corresponds to the letting information 
for that date.  There may be other information on this page, such as the number of 
proposals, a letting ID, and a description, but this information depends on the agency. 

To view a letting, click the desired letting date.  The Lettings page displays details 
specific to the letting, including the letting ID, and the number of proposals.  The Time 
Remaining section features a clock that counts down the time until the letting ends.   

The letting details page contains Also Available and Downloads sections.  The Also 
Available section lists additional information specific to the letting, such as the eligible 
plan holders and bid tabulations.  The Downloads section contains all the proposals and 
amendments for the letting.  

 

Figure 1-6.  Proposal Information for a Specific Letting 
 

The Time Remaining section displayed on the right side of the page is 
the official clock used to determine the amount of time remaining in the 
letting/bid opening.  This time is synchronized with the Naval Atomic 
Clock. 

The terminology on the Lettings tab may differ by agency.  For example, 
some agencies refer to the Letting as the Bid Opening and the Proposal 
ID as the Contract ID.  

The documents listed in the Also Available section and the Download 
section are determined by the agency.  
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  Exercise 1-6 

In the following exercise, you will navigate to the Lettings tab and open a specific 
letting.   

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. If necessary, click the desired agency in the Select an Agency drop-down list 
and click Go.  

6. Click the Lettings tab.  

7. Click the desired Letting Date link.   



1-18 Getting Started With the Bid Express Services 

Viewing a Contract 

The Contract page displays more detailed information about a Contract than is displayed 
on the list of lettings, including the item numbers and descriptions of the items.  A 
Contract page may also contain several links that allow access to online reports such as 
the specific Expedite information for the proposal or the eligible plan holders list.  These 
online reports are contract-specific. 

To view details regarding a specific contract, click the contract ID.  A new page appears 
containing specific contract information. 

 

Figure 1-7.  Contract Information 
 

Contract specific information is available on the Contracts page.  The 
Expedite files and the Amendment files are of particular interest to 
bidders who are bidding via the Internet. These files are located in the 
Download section.  
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  Exercise 1-7 

In the following exercise, you will view contract-specific information.   

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. If necessary, click the desired agency in the Select an Agency drop-down list 
and click Go.  

6. Click the Lettings tab.  

7. Click the desired Letting Date link.   

8. Click the desired Proposal ID link.   
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Performing a Search 

The Search tab allows you to search the entire Bid Express services database for bid 
tabulation, items, bidders, and Bid Express services subscribers.  

The Bids Search provides the ability to find a bid price, item number, description, 
proposal ID, quantity, unit of measure, bidder, and letting date. You are able to sort by 
any of these headings.  There is also the option to export these result by clicking the 
Export tab on the top right corner. The results are displayed by 20 items per page and it is 
paginated.    

The Item Search provides a search for an item description from a contract, including the 
contract ID, item number, description, quantity, and letting date. The Item Search results 
can be sorted by any of the headings. There is also the option to export these result by 
clicking the Export tab on the top right corner. The results are displayed by 20 items per 
page and it is paginated.    

The Bidders Search searches the bidder ID, address, phone number, or other information 
related to a bidder.  The Bidders search results can be sorted by Bidder ID, Name , 
Address, City or State.  

The Bid Express Subscribers Search can find information about a subscriber, including 
the name of the subscriber, name of the company, and address.  This search only yields 
information about subscribers who agreed to have their contact information published.  
Search results can be sorted by Organization, Name, or Address.  

 

Figure 1-8.  Search Tab 

To use the search function, click the type of search desired:  bids, items, bidders, or 
subscribers. Click in the Keywords field for that search. Enter the keyword.  Upon 
entering the keyword the results automatically populate. The Bid Express website 
displays 20 results per page.  You can download the results as a CSV file as well. 

All searches in the Search Tab provide you the capability of performing an advance 
search. To perform an advance search, first select the type of search then click the 
advance button at the top right side of the page. The advance search allows you to search 
with more options including date ranges and items description. 
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Figure 1-9.  Item Search Results 

  Exercise 1-8 

In the following exercise, you will perform an item search.   

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. If necessary, click the desired agency in the Select an Agency drop-down list 
and click Go.  

6. Click the Search tab.   

7. Select the type of search you wish to perform.  

8. Enter the keyword in the field provided or click the Advance button to search 
with more detail.  
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Accessing Help, FAQs, and Customer Support 

In addition to the Training Center, assistance with the Bid Express service is available 
through FAQs, online Help, and Bid Express customer support.  

Frequently Asked Questions 

The FAQs cover questions in several categories.  Each category covers the frequently 
asked questions that relate to the heading.  FAQs can be accessed from the Bid Express 
home page by clicking Questions/Help.  

 

Figure 1-10.  FAQs Page 
 

The FAQs page is accessed from the Bid Express home page.  
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  Exercise 1-9 

In the following exercise, you will access the Frequently Asked Questions area button.   

1. Go to http://www.bidx.com.  

2. Click Questions/Help.  

3. Click the desired link. 

Online Help  

The Help button appears in the form of a question mark on all the Bid Express services 
pages.  Clicking the Help button (a question mark) displays a help section specific to that 
particular page in a new browser window.   

When you are finished viewing the help, you can close the browser or use the table of 
contents to find help on another topic. 

 

Figure 1-11.  Help Button 
 

The Help page displays information specific to the current page of the 
Bid Express website.  

  Exercise 1-10 

In the following exercise, you will access the online help.   

1. Go to http://www.bidx.com.  

2. Select an agency from the drop-down list and click Go. 

3. Click the Help button.  

4.  Close the help browser.  
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Accessing Customer Support  

Customer support for Bid Express services is available from 7:00 a.m. until 7:00 p.m., 
EST.  During those hours, a Customer Support Specialist can be reached by dialing (352) 
381-4888 or (888) 352-BIDX (2439).  After 7:00 p.m., a voice message can be recorded 
for customer support.  A support specialist will receive the message the morning of the 
next business day and processes the call. 

 

Bid Express Customer Support Contact Information: 

By Mail: 
Bid Express 
5700 SW 34th St., Suite 1235 
Gainesville, FL 32608-5371  

By Phone or Fax: 
Tel: (352) 381-4888  
Toll Free:  (888) 352-BIDX (2439) 
Fax: (352) 381-4444 

By email:  
Support: customer.support@bidx.com 
Feedback: feedback@bidx.com 
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Review for Section 1

To navigate to the Bid Express website: 

1. Go to http://www.bidx.com.  

To subscribe to the Bid Express services: 

1. Go to http://www.bidx.com.  
2. Click Order and then click Fee 

Schedule.  
3. Review the available services and 

associated fees.  
4. Click the Order Tab then click 

Subscribe Now!  
5. Enter a valid email address.  
6. Enter a password, select the agency 

you were referred by and agree to the 
Bid Express Subscriber agreement 
and Acceptable Use policy. Click 
Submit.  

7. Go to the email account entered to 
subscribe and locate the email sent to 
activate the account. 

8. Click the link in the email and enter 
the account password.  

9. Complete the Bid Express Service 
Form.  

10. Click the Save button.   

To log on to the Bid Express website: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button. 

To navigate to an agency’s home page: 

1. Go to http://www.bidx.com.  
2. In the Select an Agency drop-down 

list, click the expand arrow and click 
the desired agency.  

3. Click the Go button. 

To access the My Bidx page:  

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  

4. Click the Log In button. 
5. Click the My Bidx icon on the top 

right corner.  
6.  Click the desired link to perform any 

change needed.  

To change your password: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button. 
5. Click the My Bidx icon on the top 

right corner  
6. Click the Password link. 
7. In the Current Password field, type 

your password.  
8. In the New Password field, type the 

desired new password.   
9. In the Re-type New Password field, 

type the new password.   
10. Click the Save button.  

To access the Training Center: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button. 
5. Click the training center link at the 

bottom of any of the webpages.  

To view the Lettings page: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button. 
5. If necessary, select your agency from 

the Select an Agency drop-down list, 
and click Go.  

6. Click the Lettings tab.  
7. Click the desired Letting Date link.  
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To view the proposal page: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button. 
5. If necessary, select your agency from 

the Select an Agency drop-down list, 
and click Go.  

6. Click the Lettings tab.  
7. Click the desired Letting Date link.  
8. Click the desired proposal link.   

To perform a Search: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button. 

5. If necessary, select your agency from 
the Select an Agency drop-down list, 
and click Go.  

6. Click the Search tab.  
7. Select the type of search. 
8. Enter the search word in the 

Keywords field.  

To access Frequently Asked Questions:  

1. Go to http://www.bidx.com.  
2. Click the questions/help link. 
3. Click the desired topic link. 

To access Online Help: 

1. Go to http://www.bidx.com. 
2. Navigate to the desired area.  
3. Click the Help button.  
4. Close the browser to exit the help. 
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2.  Managing a Digital ID 

By the end of this section, you will be able to: 

 Understand the Purpose of the Digital ID 

 Download the Expedite Bid Software 

 Configure the Expedite Bid Software 

 Create a Digital ID for Bidding With a State or Local Agency 

 Check the Status of Your Digital ID 

 Export and Import a Digital ID 
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Understanding the Purpose of the Digital ID 

A digital ID is a signature that is the legal equivalent of a written signature, thus allowing 
for the digital signing of files.  If you wish to submit bids via the Internet, you will need 
to obtain a digital ID.  There is a processing fee for each digital ID issued.  One digital ID 
is required for each individual submitting bids over the Internet and each digital ID works 
for only one state transportation agency.  Individuals must register a digital ID for each 
state transportation agency to which they bid.  If the individual is interested in bidding in 
a local agency rather than with a Department of Transportation (DOT), then only one 
digital ID is needed.  

Individuals may not share a digital ID; each one identifies a particular person for a 
particular company.  However, any number of people at your business can each have 
their own digital IDs, and if they are authorized to sign for the company, any of them can 
digitally sign bids.  If you change your company name, add a joint venture, or become a 
subsidiary company, you will need to obtain a new digital ID and pay the associated fees.  
If your backup digital ID file becomes corrupted and you lose your digital ID or forget 
the password, you will need to obtain a new digital ID to replace the one lost and pay the 
associated fees. 

To begin bidding over the Internet using the Bid Express services, your digital ID must 
be approved and activated by the Bid Express Administration and the agency.  To register 
and activate a digital ID, you must mail the original printouts, signed and notarized, to 
Bid Express administration at Info Tech, Inc. Once your paperwork has been received 
and approved by Bid Express administration and the agency (if applicable), the digital ID 
will be activated.  You will be notified via email that your digital ID can be used to sign 
and submit your bids using the Expedite Bid software and the Bid Express service. 

 

You should allow five business days for processing the digital ID once 
Bid Express administration receives the correct and complete 
application.  Please note that there are no exceptions to this policy and 
there is no way to expedite this process.  
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Downloading the Expedite Bid Software  

The Expedite Bid Manager program (BID) allows bidders to create electronic bid 
documents and back up their digital IDs.  

The Expedite Bid software can be downloaded from the Bid Express home page of the 
agency with which you bid. The link to the software is located on the right hand side of 
the agency home page in the provided Download section. Prior to downloading the 
Expedite Bid software, you must complete a form regarding the software’s export 
restrictions.  Expedite Bid software contains underlying program code that incorporates 
strong encryption technology and therefore is subject to export restrictions.  Its 
distribution may be regulated by 15 CFR Parts 730-774, published by the U.S. 
Department of Commerce, Bureau of Export Administration, as the Export 
Administration Regulations (EAR), and probably other laws and regulations.  If you do 
not meet the requirements set forth on this page, you may not be eligible to download 
Expedite Bid software.  

 

Figure 2-1.  Expedite Export Control Form 

Once the form is complete, click the Download Expedite Bid button and select the 
agency to which you would like to bid.  

 

If bidding over the Internet in multiple agencies, you should verify the 
version of the Expedite Bid software used by each agency. It is possible 
to have multiple versions of the Expedite Bid software as long as they 
are installed in different directories on your computer.   
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  Exercise 2-1 

In the following exercise, you will download the Expedite Bid software.  

1. Go to http://www.bidx.com.  

2. In the username field, type your user name.  

3. In the password field, type your password.  

4. Click the Log In button.  

5. If necessary, select your agency from the Select an Agency drop-down list, 
and click Go.  

6. Click the Expedite Bid link listed under the Download section on the right 
side of the page. 

7. Enter the required information in the Expedite Export Control form.  

8. Click the Download Expedite Bid button.  

9. Scroll to the desired agency and click the Download Expedite Bid link. This 
step downloads the Expedite Bid software to your computer.  

10. Click the Run button twice.  

11. Complete the steps in the Installation Wizard. The download is complete 
when you click the Finish button.  
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Configuring the Expedite Bid Software  

The first time you enter the Expedite Bid software, the program will ask you to enter the 
appropriate bidder and agency information.  These configuration options can be changed 
at any time by clicking the Tools menu and then clicking the Options choice.  The 
configuration options that are available in the Expedite Bid software are described in the 
table below: 

 

Tab Description 

Bidder Information Allows you to maintain the basic bidder information, i.e., name, 
address, and telephone number of the organization. 

Agency ID Allows you to maintain the Bidder IDs (Vendor IDs). 

Unit Conversions Allows you to process English to Metric and Metric to English unit 
conversions. 

Export Format Allows you to designate the export file format type and maintains 
the fields and associated details.  You can return to system 
defaults at a later point, if necessary.  

Import Format Allows you to designate the expected import file format type and 
maintains the fields and associated details.  You can return to 
system defaults at a later point, if necessary. 

Miscellaneous Allows you to maintain assorted system indicators.  For example: 
Save the bid before printing, Check the bid before printing, Display 
the splash screen at logon, and Ask to save to floppy when saving. 

Proxy The Proxy tab is required when the Bid program is run in a 
network environment where a proxy server is used.  You must fill 
in the Proxy tab in the BID Options window in order for the Internet 
bid submission to work properly in a network environment. 

Table 2-1.  Bid Options 
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Figure 2-2. Bid Options 
 

To use the Expedite software for bidding, the Bidder Information and the 
Agency/ID folder tabs must be complete. 
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  Exercise 2-2 

In the following exercise, you will configure the Expedite Bid software.  

1. Double-click the Expedite Bid software.  

2. Click the OK button in the New Installation window.  

3. In the Bid Options window, on the Bidder Information folder tab, enter your 
company information (this information must match what the agency has on 
file).  

4. Click the Agency/ID folder tab.  

5. In the Agency field, type the agency name unless otherwise specified (if you 
are not sure, please check the Bid Express website). Enter the agency’s name 
entirely, no abbreviations. 

6. In the Bidder ID field, type your Bidder ID.  This may be either a number 
given to you by your bidding agency or your Bidx account number, which you 
can call Customer Support to obtain.   

7. Click the APPLY button.  

8. Click the OK button.  
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Creating a Digital ID for Bidding With a State or Local 
Agency 

You should know the following information before creating your digital ID: 

 The Bid Express service uses the Bid Express KeyLab to generate the key.  
In order to use this program, you will need to update your computers .NET 
framework to version 4.0.  

 The agency and Bidder ID for which the digital ID will be used.  If you are 
bidding with a local agency, your bidder ID is the same as the Bid Express 
services account login; for example, bidx1234.  If you are bidding with a 
state agency, your bidder ID is the one assigned to your company by that 
agency. 

 The name of the person eligible to sign bids as listed in the prequalification 
paperwork for the agency (if applicable).  

 A password that will be used in conjunction with the digital ID.  This 
password will be needed to submit and withdraw bids.  Once created, the 
password cannot be changed or retrieved. 

 

Choose your password carefully.  It is not possible for the Bid Express 
service to determine, recover, or change your digital ID password.  If 
you forget your password, a new digital ID must be created and you will 
need to pay associated fees.  

The digital ID is not registered and activated until all paperwork has 
been approved by Bid Express administration and the agency (if 
applicable).  

When you are finished creating the digital ID, print the Digital ID paperwork.  
Instructions and contact information as to where to mail the paperwork are included on 
the printed page.  

 

Figure 2-3. Digital IDs Page  
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When you bid with more than one local agency, you need only one digital ID.  If you bid 
with more than one state agency, you will need a unique digital ID for each agency. 

  Exercise 2-3 

In the following exercise, you will create a digital ID.  Remember the digital ID is not 
registered and activated until all paperwork has been approved by Bid Express 
administration and the agency. 

1. Login to the Bid Express service.  

2. Click the MyBidx button in the top right corner of the page. 

3. Click Digital IDs in the Account Services section. 

4. Click Create New. 

5. Click Generate ID. 

6. If you need to, click Run to start the Bid Express KeyLab. 

7. Click Next in the Bid Express KeyLab pop-up window. 

8. Enter your name in the Your Name field. 

9. Enter your company in the Company field. 

10. Select the agency with which you are bidding from the drop down list. 

11. Enter your bidder ID (also known as the vendor ID) in the Bidder ID field.  

12. Click Next. 

13. Select the check box indicating you agree to the one-time $100 charge for the 
creation of the ID and the $15.00 monthly charge to keep the ID active once it 
is enabled. 

14. Select the check box indicating you have downloaded the Expedite Bid 
software and updated your company information in  the Options window. 

15.  Click Next.    

16. Enter a password for your digital ID in the Password field of the Digital ID 
Generator in the Bid Express KeyLab. 

17. Enter the password again and click Create Digital ID. 

18.  Start the back up of your digital ID by clicking OK. 
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19. Navigate to the specific file location to where you would like your digital ID 
backed up.  It is highly recommended you choose a file location external from 
your current computer location.  Examples are: A memory stick, the company 
network, a CD, etc. 

20. Click Save after choosing the file location for your back up. 

21. Click Continue in the Bid Express KeyLab. 

22. Click Next in the Create A Digital ID window. 

23. Click Print Registration. 

24. Click Print to print the digital ID paperwork. 

25. Close the print window. 

26. Click Next in the Create A Digital ID window 

27. Click Finish. 

Once completed and notarized, the forms should be sent to the following address: 

Info Tech, Inc. 
Attn: Bid Express Administration 
5700 SW 34th St., Suite 1235 
Gainesville, FL 32608-5371 

The person who submits the digital ID request (the applicant) must be authorized by the 
agency to legally submit a bid for the company.  Additionally, the company must have a 
valid Bid Express account.  Once the completed notarized original forms are received by 
Info Tech, Inc., it may take up to five business days to process and enable the digital ID.  
You can check your digital ID status on the Bid Express website and an email will be 
sent to the address provided on the Applicant Page when the digital ID is enabled.  Once 
the digital ID is enabled, bids may be submitted over the Internet to the agency for which 
the digital ID was created.  

 

To enable your digital ID, ensure the following: 

 The company has a valid Bid Express account.  

 The submitter of the digital ID is authorized to legally submit a 
bid for the company.  

 Your paperwork is filled out completely and accurately. 

 The paperwork is mailed to the Bid Express administration at 
Info Tech, Inc.  
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Checking the Status of Your Digital ID 

You can check the status of your digital ID to see if the Bid Express service or your 
agency has approved it.  Log into www.bidx.com.  Click the MyBidx button in the top 
right corner of the page. Under Account Services click Digital IDs. From the Manage 
Digital ID console click the status that appears for your digital ID. 

 

Figure 2-4. Digital ID Status Page 

There are several statuses for your ID: 
 

Enabled  Your digital ID has been approved by both the agency 
and Bid Express administration and you can begin using 
it. 

Holding Read the explanation.  If there is something you need to 
do, such as submit additional paperwork to the agency, 
complete this action. 

Incomplete You did not finish the digital ID creation process. 
 Continue the process by clicking Continue ID 
Generation or remove the digital ID by clicking Remove 
Digital ID. 

Pending Neither Bid Express administration nor the agency have 
approved the ID. 

Rejected Read the explanation and correct the information.  Click 
Update Digital ID to access the Edit a Digital ID page. 

If your digital ID is incomplete, rejected, or held, do not create a new ID.  Fix what is 
incorrect in your current ID and resubmit it. 
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  Exercise 2-4 

In the following exercise, we will change information on the digital ID and resubmit 
it. 

1. Log in to the Bid Express service.  

2. Click the My Bidx button in the top right corner of the 
page. 

3. Click Digital IDs in the Account Services section. 

4. From the Manage Digital ID page, click the status of 
your digital ID. 

5. Click Update Digital ID. 

6. From the Create a Digital ID generator, click Update 
ID. 

7. The Bid Express KeyLab utility opens.  Click Next.   

8. Make the necessary changes to the applicant name, the 
company name, the agency with which you bid, and 
your Bidder ID. 

9. Click Next. 

10. Select the check box verifying you updated the 
information in the Expedite Bid software and click 
Next. 

11. Enter your digital ID password in the Password field 
and click Update Digital ID. 

12. Start the back up of your digital ID by clicking OK. 

13. Navigate to the specific file location to where you 
would like your digital ID backed up.  It is highly 
recommended you choose a file location external from 
your current computer location.  Examples are: A 
memory stick, the company network, a CD, etc. 

14. Click Save after choosing the file location for your 
back up. 

15. Click Continue in the Bid Express KeyLab. 

16. Click Next in the Create A Digital ID window. 
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17. Click Print Registration. 

18. Click Print to print the digital ID paperwork. 

19. Close the print window. 

20. Click Next in the Create A Digital ID window 

21. Click Finish. 

Once completed and notarized, the forms should be sent to the following address: 

Info Tech, Inc. 
Attn: Bid Express Administration 
5700 SW 34th St., Suite 1235 
Gainesville, FL 32608-5371 
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Exporting and Importing a Digital ID 

The digital ID can be exported from and imported into the Expedite Bid software.  
Exporting the digital ID allows each person working on multiple PC machines to create 
one digital ID per agency and not per computer.  

Digital IDs are exported and imported by entering the Expedite Bid software and 
selecting Manage Digital IDs from the Tools menu.  All digital IDs that are available 
display in the Digital IDs window. 

  

Figure 2-5. Exporting a Digital ID 

To export a digital ID, select the digital ID to be exported and then click the Export ID 
To File button.  When exporting a digital ID, the Expedite Bid software will request a 
location in which the Digital ID will be saved.  It is recommended that the digital ID be 
saved on a device external to the PC in case the digital ID is accidentally deleted or if the 
computer stops responding.  If a CD is selected, the digital ID must first be saved to the 
desktop before it can be saved to a CD.    

 

It is highly recommended the digital ID be backed up by exporting the ID 
in case it is accidentally deleted from the PC or if the PC becomes 
disabled.  

To import a digital ID, click the Import ID From File button and then select the ID from 
the media where it was saved.  If the ID was saved to a CD, insert the CD and transfer the 
ID to the desktop by right-clicking on the ID, selecting the down arrow next to the send 
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to field, and choosing the desktop.  Once this step is completed, you will then be able to 
click on Import ID From File, select the ID from the desktop, and click Open.   

  Exercise 2-5 

In the following exercise, you will export a digital ID.   

1. Double-click the Expedite Bid software.  

2. Select the Tools menu and then choose Manage Digital IDs.  

3. Click the desired digital ID.  

4. Click the Export ID To File button.  

5. Navigate to the location you wish to save the digital ID.  

6. Click the Save button.  

  Exercise 2-6 

In the following exercise, you will import a digital ID.   

1. Locate the location of the saved digital ID.  

2. Double-click the Expedite Bid software.  

3. Select the Tools menu and then choose Manage Digital IDs.  

4. Click the Import ID From File button.  

5. Navigate to the location where the digital ID was saved.  

6. Click the Open button.  

7. Click OK in the successfully imported key confirmation window. 

8. Click OK. 
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Review for Section 2

To download the Expedite Bid software: 

1. Login to the Bid Express service.  
2. If necessary, select your agency from 

the Select an Agency drop-down list, 
and click Go.  

3. Click the Expedite link on the agency 
home page.  

4. Enter the required information in the 
Expedite Export Control form.  

5. Click the Download Expedite Bid 
button.  

6. Scroll to and click the desired agency.  
7. Click the Expedite link. This step 

will download Expedite Bid to your 
computer.  

8. Click the Run button twice.  
9. Complete the steps in the Installation 

Wizard. The download is complete 
when you click the Finish button.  

To configure the Expedite Bid software: 

1. Double-click the Expedite Bid 
software. 

2. Click the OK button in the New 
Installation window.  

3. In the Bid Options window, on the 
Bidder Information folder tab, enter 
your company information.  

4. Click the Agency/ID folder tab.  
5. In the Agency field, type the 

agency’s abbreviation.  
6. In the Bidder ID field, type your 

Bidder ID.  
7. Click the OK button. 

To create a digital ID for a state or local agency: 

1. Click the My Bidx button in the Bid 
Express service.  

2. Select Digital IDs. 
3. Click Create New. 
4. Click Generate ID. 
5. Click Next in the Bid Express 

KeyLab utility. 
6. Read the Digital ID and fee 

information. 
7. Enter the ID holder’s name in the ID 

Holder field. 
8. Enter your company in the Company 

field. 

9. Select the agency to which you are 
bidding from the drop down list. 

10. Enter your bidder ID (also known as 
the vendor ID) in the Bidder ID field.  

11. Click Next. 
12. Select the check box authorizing Info 

Tech, Inc.  to charge your credit card. 
13. Go to the Expedite Bid software.   
14. Update your company information on 

the Options window.  
15. Select the Update Information 

check box on the Bid Express 
website. 

16. Click Next. 
17. Click Create Digital ID.   
18. Enter a password for your digital ID 

in the Password field of the Digital 
ID Generator in the Bid Express 
KeyLab. 

19. Enter the password again and click 
Create Digital ID. 

20. Click OK. 
21. Save your backup digital ID. 
22. Click Continue. 
23. Click Next. 
24. Click Print Registration and print 

your digital ID registration 
paperwork. 

25. Close the print window. 
26. Click Next. 
27. Click Finish.  
28. Follow the instructions on the 

paperwork. 

To submit the digital ID paperwork: 

1. Ensure the company has a valid Bid 
Express account.  

2. Ensure the submitter of the Digital ID 
is authorized to legally submit a bid 
for the company. 

3. Mail the original Digital ID 
Certificate Page, Applicant Page, 
Billing Page, and notarized Signature 
Page to Info Tech, Inc. 

To update information in your digital ID: 

1. Login to the Bid Express service.  
2. If necessary, select your agency from 

the Select an Agency drop-down list, 
and click Go. 
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3. Click MyBidx. 
4. Select Digital IDs. 
5. Click the status of your digital ID. 
6. Click Update Digital ID. 
7. Click Update ID. 
8. In the Bid Express KeyLab, click 

Next. 
9. Fix any incorrect information. 
10. Open the Expedite Bid software and 

update any correct information. 
11. Select the Update Information in 

Expedite Bid check box in the Bid 
Express KeyLab. 

12. Click Next. 
13. Enter your password. 
14. Click Update Digital ID. 
15. Click OK. 
16. Save your back up. 
17. Click Continue. 
18. Click Next.  
19. Print the updated paperwork. 
20. Click Next. 
21. Click Finish. 
22. Follow the instructions on the 

paperwork. 

To export a digital ID: 

1. Open the Expedite Bid software. 
2. Click the Tools menu. 
3. Click Manage Digital IDs.  
4. Click the desired Digital ID.  
5. Click the Export ID To File button.  
6. Navigate to the location you wish to 

save the digital ID.  
7. Click the Save button. 

To import a digital ID: 

1. Locate the location of the saved 
digital ID.  

2. Open the Expedite Bid software. 
3. Click the Tools men. 
4. Click Manage Digital IDs.  
5. Click the Import ID From File 

button.  
6. Navigate to the location which the 

digital ID was saved.  
7. Click the Open button.  
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3.  Submitting Bids Via the Internet 

By the end of this section, you will be able to: 

 Understand the Process of Submitting Bids Via the Internet 

 Download the Proposal 

 Open the Proposal in the Expedite Bid Program 

 Prepare a Bid 

 Verify a Bid is Complete 

 Submit a Bid 

 Withdraw a Bid 



3-2 Submitting Bids Via the Internet 

Understanding the Process of Submitting Bids Over the 
Internet 

A bid can be submitted to an agency through the Expedite Bid software, but you must 
have an active digital ID and an Internet connection.  The digital ID encrypts the bid so 
that only the intended agency may decrypt and read it.  Bids are held in a locked box and 
are not read until the bid opening date and time. 

A bid can be submitted multiple times before the deadline as only the last submission will 
be kept and passed on to the agency.  If a bid is withdrawn before the deadline, it will not 
be available for downloading. 

No one but the submitter can view the bid until the public bid opening.  Until the bid is 
deliberately submitted to the service, it stays on the PC and there is no way for anyone 
else to see it.  When a bid is submitted, the Expedite Bid software encrypts it using the 
agency’s key. The Bid Express system cannot read the bid and the bid sits in a lock box 
until the official bid opening. 

  

In order to submit a bid via the Internet, you must have the following: 

 A Bid Express account 

 The Expedite Bid software 

 An Internet connection 

 A digital ID 
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Downloading the Proposal 

Prior to submitting a bid via the Internet, the proposal must be downloaded from the 
Letting Tab on the Bid Express website so that it may be opened by the Expedite Bid 
software.   

Once you select a letting date, the Letting page displays information specific to the 
letting, including the letting description (if there is one), the letting ID, the number of 
proposals, and the time the bids are due.  It also has a section called Also Available, 
which lists information specific to the letting, such as the eligible bidders, plan holders 
lists, and bid tabulations. The section called downloads provides you with the electronic 
files needed for internet bidding. Above this information is a clock that counts down the 
time until the letting.  This is the official clock used to determine the time remaining 
before the letting ends.  Last, there is a list of Contract IDs, the call orders for those 
Contract IDs, and the county and description of the Contract IDs. 

 

Figure 3-1.  Lettings Tab 

Downloading the EBLIB File 

While on the Letting page, all proposal files for a letting can be downloaded into the 
Expedite Bid program using the EBS and Amendments Files as an EBLIB file option.  
Click the EBLIB file hyperlink.  A window opens asking to save the file or open it.  Save 
it to the location of your choice (we recommend that you also save it in a media other 
than the PC in case the computer stops working).  Once the file is saved, open the 
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Expedite Bid software.  Select the File menu and then click Open Proposal.  The 
Expedite Bid programs opens an Open Proposal window.  Find the location of the saved 
file and click it once.  When the file name appears in the File Name window, click Open.   

 Note:  Downloading the EBLIB file from the Letting page downloads all 
the proposals for that letting. 

Downloading the EBS File 

The Contracts page is accessed by clicking on the desired Contract ID.  The EBS file is 
located in the Download area on the Contracts page.  

The EBS file is a proposal file that can be opened with the Expedite Bid software.  It 
contains all the information included on the proposal page in an .ebs file format.  
Although using the Expedite Bid program is not necessary in order to use the Bid Express 
service for informational purposes, it is required for Internet submission.   

Click the Expedite Data File (the .ebs file) hyperlink.  The file download window opens 
with options for saving or opening the file.  We recommend that you always save rather 
than open the file in case the agency posts an amendment to the file and it needs to be 
updated.  In order to attach an amendment to an EBS file with added bid information, the 
amendment needs to be saved in the exact location as the EBS file.  Do not change the 
file name as this was created by the agency.  When the agency downloads the file after 
the letting has ended, the system verifies the file name.   

Once the file has been saved to the desired location, open the Expedite Bid program.  
Select the File menu and then select Open Proposal.  Find the location of the saved file, 
click it once, and then click Open. 

The .ebs file displays the items in the call order that appear on your screen when you 
click the call order on the Bid Express website.  You can enter the necessary information 
in the proposal in Expedite Bid and use the bid submission process to send the bid to the 
agency. 

 

Figure 3-2.  Proposal Page With EBS Files and Amendments  
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Downloading Amendment Files 

To download an amendment file, click the amendment for the call order on the Bid 
Express website.  A window opens asking if you want to open the file or save it.  Since 
amendment files have to be added to the Expedite Data File you will need to save the file 
in the exact location where the proposal file was previously saved.  If you click Open, 
you will receive an error message since the only way to view the amendment is by 
opening the proposal with the amendment. 

Once the file has been downloaded, open the original proposal in the Expedite Bid 
software.  Since the amendment was saved in the same location as the EBS file, it will 
automatically attach and update the proposal.  Amendment files are always denoted by a 
*.00n file extension (e.g. 17jun041.003 would be the third amendment for Call Order 41 
to be let on June 17).  Upon opening the proposal in the Expedite Bid program, a window 
appears denoting what changes were made.  Print the changes then click OK to apply 
those changes automatically to the proposal file. 

If there is more than one amendment for a call order, you must sequentially download 
and apply each amendment to the call order.   

Downloading an EBLIB File From the Proposal Page 

An EBLIB file will always be generated when the agency creates an amendment.  Unlike 
the EBLIB file found on the Lettings page, this EBLIB file only contains the EBS file 
and all the amendments for the selected project/proposal.  It is recommended that you 
download the EBLIB file only if no work has been done on the EBS file in the Expedite 
Bid software.  Downloading the EBLIB file automatically replaces the EBS file, so don’t 
use this option if you’ve already started working on the EBS file or you will lose your 
work.   

To download the proposal EBLIB file, click the hyperlink.  A download window appears.  
Select Save and the location where you would like to save the file.  Remember not to 
change the file name. Click Save. 

 

All proposals and amendments for a letting may be downloaded as an 
EBLIB file from the Lettings page.  

One proposal may be downloaded as an ebs file from the Contracts 
page. If an Expedite Data File (.ebs) is downloaded, each amendment 
must also be sequentially downloaded and loaded into the Expedite Bid 
program.  
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  Exercise 3-1 

In the following exercise, you will download an Expedite Data File (.ebs).  

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the password field, type your password.  

4. If necessary, click the desired agency in the Select an Agency drop-down list 
and click Go.  

5. Click the Lettings (or Projects) tab.   

6. Click the desired Letting Date or Project.  

7. Click the desired proposal.  

8. In the Downloads section, click the Expedite file.  

9. Save the EBS file to the desired location.  
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Opening the Proposal in the Expedite Bid Program 

Each proposal can be opened individually in the Expedite Bid Program or all the 
proposals in a letting can be opened at once.  Additionally, amendments can be merged 
into a proposal.  

To open a single electronic proposal, select the File menu in the Expedite Bid Program, 
then select Open Proposal.  An open proposal window appears.  Navigate to the location 
where you saved the file, select the EBS file, and then click Open.  The Expedite Bid 
software displays the proposal and identifies it in the title bar. 

To open all the proposals in a letting, select the File menu then select Open Letting.  A 
browse for folder window opens.  Navigate to the location where the letting was saved, 
highlight the desired file and click OK.  The Expedite Bid program displays the letting 
and identifies it in the title bar.  All the proposals in the letting are displayed in a tree 
view in the left pane of the window.  Detail information about the letting is displayed in 
the right pane.  Click a proposal folder in the tree view to open the proposal.  The 
Expedite Bid software displays the Proposal window with the name of the proposal in the 
title bar and detailed information about the proposal in the right pane of the window.  
Only open one proposal in the letting at a time.  The folders for the proposal that is 
currently open are red or green, depending on the completeness of the bid.  All other 
proposal folders in the letting remain yellow. 

After an Expedite Bid proposal/bid has been opened in the Expedite Bid software, you 
can load and incorporate Expedite amendment files.  The Expedite Bid software ensures 
that amendments are loaded in order or it will refuse to load the amendment.  
Amendments can change general proposal data (such as descriptions and amendment 
notes) and item data (such as quantities), as well as add or delete items.  Changes to item 
data will cause only those item prices previously entered to be erased and turn the folder 
red.  The bidder will need to review those items that were changed by the amendment and 
add prices again. 

After downloading the amendment file from the Bid Express website, save the new 
amendment file (it will have the same name as the proposal file, except for an extension 
of 001, 002 or so on) in the same directory with the proposal file.  Open the Expedite Bid 
program.  Select the File menu and then select Open Proposal.  An Open Proposal 
window appears.  Navigate to the directory where the proposal was saved, click the file, 
and click Open.  If the amendment was saved in the same directory, opening the EBS file 
automatically attaches the amendment to the proposal.  A Select Proposal window 
appears.  Click the proposal and then click OK.  An Amendment Changes window 
displays, indicating all the changes that will be applied to the proposal.  At this point you 
can print the page or click OK to apply the amendment.  



3-8 Submitting Bids Via the Internet 

 

Figure 3-3.  The Amendment Changes Window 
 

An EBS file contains only the information for a particular proposal in 
a letting.  

An EBLIB file from the Lettings page contains all proposals and 
amendments for a letting.  

  Exercise 3-2 

In the following exercise, you will open a proposal in the Expedite Bid program.  

1. Double-click the Expedite Bid icon on your desktop (a small yellow triangle).  

2. Click the File menu and then click Open Proposal.  

3. Navigate to the location where the EBS file is saved.  

4. Click the desired EBS file.  

5. Click the Open button.  
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Preparing a Bid 

The left pane of the Proposal window displays a tree view of the proposal and the right 
pane displays general information about the proposal.  When a single proposal is opened, 
the folders in the tree view are red until all the information has been entered properly for 
that proposal, at which time the folders turns green.   

The number and type of folders available on the left side of the proposal window will 
vary due to the type of Contract (e.g. State or Federal) and the Expedite Bid options 
chosen by the agency.  Folders could include the following: 

 Schedule of Items 

 Bid Bonds  

 DBE Goals 

 Agency Forms 

Entering Item Prices 

After you have started the Expedite Bid software and selected an electronic proposal, 
begin entering item bid prices in the Schedule of Items.  To enter item prices, click the 
plus sign [+] to the left of the Proposal number in the left pane of the Proposal window so 
the tree view expands.  (You are also able to change the view of the proposal by selecting 
the Grid View from the View menu.)   

Click the Schedule of Items folder on the left side of the window.  The Expedite Bid 
program displays the Schedule of Items in grid form on the right pane.  Type the amount 
you want to bid and then press the Tab key or click the next empty field.  The Expedite 
Bid software computes the Extension, the Section Total, and the Bid Total immediately.  
Repeat this step to bid the remaining line items.  Once an item price has been entered for 
each item, the folder turns green.  
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Figure 3-4. Schedule of Items Window (Grid View) 
 

A price must be entered for each item before the Schedule of Items 
folder will turn from red to green.   

If desired, the Schedule of Items can be exported from the Expedite Bid 
software, the item prices entered in another program, and then imported 
back into the Expedite Bid software.  

  Exercise 3-3 

In the following exercise, you will enter item prices in the Expedite Bid program.  

1. Click the plus sign [+] to the left of the Proposal number in the left pane of 
the Proposal window  

2. Click the Schedule of Items folder.  

3. Click the Unit Price field for the desired item and type the desired unit price.  

4. Repeat step 3 until unit prices are entered for each item.  

5. Click the Save button.   
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Entering Bid Bond Information 

It is the agency’s decision to include the Bid Bond form as part of the proposal.  If using 
Bid Bonds, it will display as a folder in the left side of the window.  It is possible that this 
screen is not available.  

The Bid Bond window contains information that the agency would like the bidder to read 
and possibly record.  The agency can customize this form to collect bid bond information.  
Some agencies use this screen to collect information about the surety company and the 
surety state of incorporation as well as the bidder’s bond ID and maximum bond amount 
allowed. 

The agency can make any field it creates optional or required.  If the agency has 
designated a field as required and it is not filled in, a <BOND RECORD IS 
INCOMPLETE> warning appears at the top of the screen.  Once all the required fields 
are filled in, the warning disappears and the folder turns green.  

The agency may also provide options with which a bidder can handle bid bonds: 

 The agency can set a default function to handle all bid bonds as a set 
percentage of the bid, usually a whole number.  For example, an agency 
might set 15 percent which the Expedite Bid software would calculate into 
a bond amount.  The set percentage and the calculated bond amount would 
display below the separator at the bottom of the Bid Bond window.  

 The agency might allow bidders to pay their bid bonds by certified check 
(or another form of payment) by selecting the designated payment option 
check box.  If this option is active and a bidder selects it, the Expedite Bid 
program disables all other fields on the Bid Bond window since the 
information in those fields would no longer be necessary.  The <BOND 
RECORD IS INCOMPLETE> warning at the top of the screen will also 
disappear. 

 The agency might request the maximum bond amount set by a surety 
company for a bidding contractor.  The Expedite Bid program will 
compare the maximum bond amount entered in the Max Bond Amt field 
with the calculated bond amount displayed at the bottom of the Bid Bond 
window.  If the calculated bond amount exceeds the maximum bond 
amount, the bidder will receive a warning when the Check Bid button is 
clicked. 

The agency may also customize the Bid Bond form to allow bidders to verify their bid 
bond via the Internet.  To have a bidder verify a bid bond this way, the Verify and Clear 
buttons will be available.  Only bonds secured though Insure Vision and Surety 2000 may 
be verified over the Internet.  
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 Figure 3-5.   Bid Bonds Window 
 

Refer to your agency specifications regarding how Bid Bonds will be 
handled.  

Registration is required with Insure Vision or Surety 2000 to use Internet 
bid bond verification.  The bidders as well as their bonding agents will 
need to sign up with either company to be able to verify their bid bonds 
via the Internet. 

  Exercise 3-4 

In the following exercise, you will enter bid bond information in the Expedite Bid 
program.  

1. Click the Bid Bond folder.  

2. Select the Pay by Certified Check check box.  

3. Click the Save button.   
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Downloading the DBE.bin File 

If a DBE.BIN file is provided by the agency, it appears for a letting in the Also Available 
section.  To download the DBE.BIN file, click the file and save it to the same location 
where the bid file is saved. The DBE.BIN file attaches to your bid file when the bid file is 
opened.  From there, you can add DBEs from the drop down menus. 

Entering DBE Commitments 

It is the agency’s decision to include tracking line item DBE commitments as part of the 
proposal.  If using this option, a DBE folder will display in the left side of the window.  It 
is possible that this screen is not available.  

A bidder can add a DBE subcontractor to the proposal by clicking the Add DBE button.  
Depending on agency options, the contractor’s name and address can be typed into the 
fields or it can be selected from a predetermined list.  If a DBE list has been created by 
the agency, you will need to download that file and save it in the exact location of the 
proposal in order to be able to add any contractors from the list.  To download the DBE 
BIN file, access the Bid Express website and select the date of the letting in the  
Downloads section on the Letting Page.  Click the DBE BIN file link, click Save, select 
the location where you saved the proposal, and click Save again.  In order to be able to 
select from the list provided by the agency you will need to reopen the proposal (if it was 
already open) and the DBE file will automatically attach to the proposal. 

 

Figure 3-6.  DBE Window 

Once the DBE has been entered, items can be associated to that subcontractor (if the 
agency requires it) by clicking the yellow folder that appears on the left had side of the 
window under the name of the DBE.  The DBE Items window appears in the right side of 
the window.  This window is divided into two sections (see Figure 3-7): 
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 The upper section of the window contains a scrollable list of all the items in 
the contract.  The list is organized by section and line numbers. 

 The lower section of the window contains information about the item 
currently selected in the list as well as editable fields for Quantity, Unit 
Price, Total, and Notes. 

The bidders should select the items that should be associated to the subcontractor, 
complete the bottom part of the window for each item as needed and then save.  The 
Quantity field can be changed at any time.  The Unit Price is initially populated with the 
proposal item unit price.  This field can also be edited.  If the field value is changed, then 
the Total is recalculated by multiplying the new unit price by the quantity.  The Extension 
amount field is calculated as the product of the quantity and the unit price.  This field can 
also be edited.  If the field value is changed, then the quantity is recalculated by dividing 
the new extension by the unit price.  

If more than one DBE file needs to be created, click ADD DBE at the bottom of the page 
to create a new entry.  If the agency does not require that the proposal state the items then 
enter the quote amount on the DBE entry as provided by the agency.  This process should 
be repeated for all DBEs.  Once the DBE goal has been fulfilled, the folder will turn 
green. 

 

Figure 3-7.  DBE Items Window 
 

Refer to your agency specifications regarding how DBEs will be 
handled.   
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  Exercise 3-5 

In the following exercise, you will enter a DBE and item commitments in the Expedite 
Bid software.  

1. Click the DBE List folder.  

2. Click the Add DBE button.  

3. In the Name drop-down list, click the expand arrow and click the desired 
DBE.  

4. Click the Save button.   

5. Click the DBE items list on the left hand side just under the name of the 
contractor.  

6. Select the check box for the desired items and complete the information 
requested.  

7. Click the Save button.  

8. Repeat steps 2-7 until all DBEs and items are listed.  
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Entering Agency Data Entry Screens 

It is the agency’s decision to include the data entry folders as part of the proposal.  If 
using miscellaneous folders, they will display in the left side of the window.  It is 
possible that these screens are not available and it is possible to have multiple folders.  

Any type of form for gathering miscellaneous information can be created.  Some agencies 
use these screens to display contractual information or use it as a checklist to ensure that 
all elements of the bid process have been completed.  To view the data entry screen, click 
the desired miscellaneous Data Entry folder option on the left side of the window.  The 
selected Data Entry window appears.  The Data Entry window contains information that 
the agency would like recorded.   

The agencies have complete control over customizing the entry screens.  The bidder 
should enter all the required fields in the Data Entry folder, moving through the form 
from top to bottom using the Tab key or scroll bars on the side of the window.  Once all 
the required fields are filled in, the folders turn green. 

After all the Data Entry window fields are entered, click the Save button on the Tool bar 
to save the bid.  Then select the next Data Entry folder in the left pane and repeat the 
process. 

 

Figure 3-8.   Data Entry Window 
 

Refer to your agency for information regarding what Data Entry folders 
will be used.  

All required information must be entered in the Data Entry folder for it to 
turn green.   
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  Exercise 3-6 

In the following exercise, you will enter information in a Data Entry folder in the 
Expedite Bid program.  

1. Click the desired Data Entry folder.  

2. Enter the required information.  

3. Click the Save button.   

4. Repeat steps 1-3 until all Data Entry folders are complete.  
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Verifying a Bid is Complete 

Prior to submitting the bid, the bidder should verify that all sections of the bid have been 
completed.  The Expedite Bid software automatically turns the folders from red to green 
when all required information has been entered.  The bidder can also select to view the 
Bid Errors window by selecting Check Bid from the Tools menu or clicking the yellow 
check mark found on the right hand side of the tool bar.  The Bid Errors window lists any 
errors that the proposal contains.  

 

Figure 3-9.  Check Bid Button 

 

Figure 3-10.  Bid Errors Window  
 

The Expedite Bid software and the Bid Express service allow a bid to be 
submitted with red and yellow folders. Refer to your agency for policy 
information regarding incomplete bids and bids with errors.  
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  Exercise 3-7 

In the following exercise, you will verify a bid.   

1. Click the Check Bid button.  

2. View the Bid Errors window.  

3. Click the OK button.  
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Submitting a Bid 

Before a bid can be submitted via the Internet, the bidder must have a digital ID and an 
active Bid Express account.  

Depending on the agency, you may have the option of conditionally withdrawing a bid if 
bidding on more than one proposal for the same letting to prevent you from acquiring 
more work than you are able complete.  By setting a conditional withdrawal of the bid, 
the last bid submitted will automatically be withdrawn if you are the apparent low bidder 
in any of the previous bids submitted.  The bid that gets withdrawn is the last one 
submitted regardless of the call order number.  Therefore, if you submit a bid because 
better prices were obtained, and that is not the bid you would like withdrawn, then you 
will need to resubmit the proposal that you would like withdrawn after you submit the bid 
with better prices.  The bid that is automatically withdrawn is never seen by the agency or 
any other third party. 

After completing the necessary bid submission information, submit the bid by selecting 
Submit Bid from the Tools menu or the black lightning bolt located on the right hand side 
of the tool bar.  The Bid Submission Wizard asks if you want to use automatic bid 
withdrawals.  Select Yes or No depending on your preference, and click the Next button.  
The printed bid submission receipt for a submitted bid contains information describing 
what automatic bid withdrawal conditions exist, if any, for that proposal. 

 

Figure 3-11.  Bid Submission Wizard 

Bidders can make modifications to the bid after it has been submitted to the agency at any 
time before the Bid Opening.  To resubmit a bid, open the existing bid in the Expedite 
Bid program, make the necessary modifications and then resubmit the bid using the Bid 
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Submission Wizard.  This process overwrites the bid on the Bid Express servers.  Only 
the last bid submitted is available for the agency. 

 

The Bidder must have a Digital ID and an active Bid Express account to 
submit a bid via the Internet.  

The bidder must complete all the steps in the Bid Submission Wizard 
including printing the Bid Submission Receipt in order for the bid to be 
submitted.  

If the Bid does not have all the posted amendments, the bid submission 
will be rejected.   

Bidders are encouraged to submit bids as early as possible as they can 
be updated with new quotes and amendments up until the bid opening. 

  Exercise 3-8 

In the following exercise, you will submit a bid.   

1. Open the Expedite Bid software and click the Bid Submission button.  

2. The Bid Submission Wizard opens. Make sure you are connected to the 
Internet and a printer then click the Next button. 

3. Select the Agency ID in the Agency drop down list. 

4. Enter your digital ID password in the Password field.  

5. Click the Next button. 

6. Once the password has been verified, the bid will be signed, encrypted and 
sent to the Bid Express server. Click the Next button. 

7. Print the Bid Submission Receipt as documentation that a bid has been 
submitted.   

8. Click the Next button. 

9. Click the Finish button. 
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Withdrawing a Bid  

Once a bid has been submitted, it may be withdrawn as long as it is prior to the Bid 
Opening.  If a bid is withdrawn, it is never seen by the agency.  

To withdraw a bid, click the Tools menu and select View Submitted Bids.  A wizard 
opens.  Follow all directions of the wizard to withdraw the desired bid.  

 

Figure 3-12.  Withdrawing a Bid 
 

A bid can be withdrawn up until the time of Bid Opening. A withdrawn 
bid is never viewed by the agency.   

You do not need to withdraw a bid to submit an updated bid. 

Refer to your agency procedures for information regarding conditional 
withdrawing of bids.  
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  Exercise 3-9 

In the following exercise, you will withdraw a bid.   

1. Open the Expedite Bid software . 

2. Click the Tools menu and then click View Submitted Bids.  

3. The Bid View Wizard opens. Make sure you are connected to the Internet 
and a printer, then click the Next button. 

4. Select the agency digital ID from the drop down list. 

5. Enter your digital ID password in the Password field. 

6. Click the Next button. 

7. Once the password has been verified you will see a list of proposals submitted 
by your ID for that agency.  Select the proposal you wish to withdraw by 
clicking on it. 

8. Click the Withdraw Bid button.  

9. Click the Yes button on the confirmation pop-up window.  

10. Click the Print button to obtain the receipt documenting that a bid has been 
withdrawn.   

11. Click the Finish button. 
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Review for Section 3

To download an Expedite data file:  

1. Go to http://www.bidx.com.  
2. In the Email field, type your user name.  
3. In the Password field, type your 

password.  
4. If necessary, click the desired agency in 

the Select an Agency drop-down list and 
click Go. 

5. Click the Lettings tab.  
6. Click the desired Letting Date.  
7. Click the desired proposal.  
8. In the  Downloads section, click the 

Expedite file link.  
9.  Save the EBS file to the desired location. 

To download an Expedite Amendment file: 

1. Go to http://www.bidx.com. 
2. In the Email field, type your email address. 
3. In the Password field, type your password. 
4. If necessary, click the desired agency in the 

Select an Agency drop-down list and click 
Go. 

5. Click the Lettings tab.  
6. Click the desired Letting Date.  
7. Click the desired proposal.  
8. In the Downloads section, click the 

Expedite amendment file link. 
9. Save the Amendment file to the desired 

location. 

To download an EBLIB file for the letting: 

1. Go to http://www.bidx.com. 
2. In the Email field, type your user name.  
3. In the Password field, type your password.  
4. If necessary, click the desired agency in the 

Select an Agency drop-down list and click 
Go. 

5. Click the Lettings tab. 
6. Click the desired Letting Date. 
7. In the Downloads section, click the All EBS 

Files link. 
8. Save the files file to the desired location. 

To download an EBLIB file for a contract: 

1. Go to http://www.bidx.com. 
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. If necessary, click the desired agency in the 

Select an Agency drop-down list and click 
Go. 

5. Click the Lettings tab. 
6. Click the desired Letting Date. 
7. Click the desired Contract ID. 
8. In the Downloads section, click the All of 

the above as one EBLib File link. 
9. Save the EBS file to the desired location. 

To open a proposal in the Expedite Bid program: 

1. Double-click the Expedite Bid software.  
2. From the menu click File then click the 

Open Proposal choice.  
3. Navigate to the location which the ebs file 

is saved.  
4. Click the desired EBS file.  
5. Click the Open button. 

To enter item prices in the proposal in the Expedite 
Bid program: 

1. Click the plus sign [+] to the left of the 
Proposal number in the left pane of the 
Proposal window  

2. Click the Schedule of Items folder.  
3. Click the Unit Price field for the desired 

item and type the desired unit price.  
4. Repeat step 3 until unit prices are entered 

for each item.  
5. Click the Save button. 

To enter bid bond information in the Expedite Bid 
program: 

1. Click the Bid Bond folder.  
2. Enter the desired bid bond information.  
3. Click the Save button.   
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To enter a DBE and item commitments in the 
Expedite Bid program: 

1. After downloading the DBE BIN file click 
the DBE folder.  

2. Click the Add DBE button.  
3. In the Name drop-down list, click the 

expand arrow and click the desired DBE.  
4. Click the Save button.   
5. Click the yellow item folder created under 

the DBE folder.  
6. Select the check box for the desired items 

and enter all information needed per item.  
7. Click the Save button.  
8. Repeat steps 2-7 until all DBEs and items 

are listed. 

To enter information in a Data Entry folder in the 
Expedite Bid program: 

1. Click the desired Data Entry folder.  
2. Enter the required information.  
3. Click the Save button.   
4. Repeat steps 1-3 until all Data Entry 

folders are complete. 

To verify a bid in the Expedite Bid program: 

1. Click the Check Bid button.  
2. View the Bid Errors window.  
3. Click the OK button. 

To submit a bid in the Expedite Bid program: 

1. Open the Expedite Bid software. 
2. Click the Bid Submission button.  
3. Complete the steps in the Bid Submission 

Wizard. The Bid Submission Receipt is 
printed as documentation that a bid has 
been submitted.   

4. Click the Finish button. 

To withdraw a bid in the Expedite Bid program: 

1. Open the Expedite Bid software. 
2. Click the Tools menu and then click the 

View Submitted Bids choice.  
3. The Bid View Wizard opens. 
4. Select the agency from the drop down list. 
5. Enter your digital ID password. 
6. Click the Next button. 
7. Once the password has been verified you 

will see a list of proposals  
8. submitted by your ID for that agency.  

Select the proposal you wish to withdraw 
by clicking on it. 

9. Click the Withdraw Bid button.  
10. Click the Yes button on the confirmation 

pop-up window.  
11. Click the Print button to obtain the 

receipt documenting that a bid has been 
withdrawn.  

12. Click the Finish button. 
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4.  Understanding Additional Bid Express 
Services 

By the end of this section, you will be able to: 

 Analyze Bids With the Bid Tab Analysis Service 

 Download Plans From the Online Plan Sheets Service 

 Navigate the Bid Express Message Center 

 Use the Small Business Network 
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Analyzing Bids With the Bid Tab Analysis Service 

The Bid Tab Analysis service allows you to view past bid prices and low, average, and 
high prices for items in a variety of formats including by proposal, items, and bidder.  
With this service, you can perform many different analyses quickly and easily and access 
bid tab data from most Bid Express agencies.     

To use the Bid Tab Analysis feature, enter search criteria for an item, description, 
proposal items, county, units, or number of low bidders.  You can provide a specific date 
range, quantity range, or price range. The Bid Express website displays additional 
information about the specifics you have requested.  

  

Figure 4-1.  Bid Tab Analysis Tab 

Once the search has been completed, the Bid Express website displays the results in a 
table.  Most of the table column headings include a definition or description of the 
column when the mouse is placed over the title of the column.  Each line in the table can 
be expanded to see more information about the item and the item bid information.  To see 
this additional information, click the plus sign (+) for the item number in the Item 
Number column.  The columns displayed on the Bid Tab Analysis tab are as follows: 

 

Field Name Description 

Item  The identifying number of the item. 

Description The description of the item. 

Average Bid The average of all the bids for that item per unit quantity. 

High Bid The highest unit price of the item based on the total number of 
bids. 

Low Bid The lowest unit price of the item based on the total number of 
bids. 

 Bid Count The number of proposals in which this item appears. 

Table 4-1.  Bid Tab Analysis Tab Column Definitions 
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Figure 4-2.  Bid Tab Analysis Search Results 

If the information is expanded and a letting date or proposal number is selected, the Bid 
Express website displays the letting or proposal information. 

Select the bid count to see the item bid history for the selected item 

.  

Figure 4-3.  Bid Tab Analysis Contract Specific Results 

The Bid Tab Analysis tab is an optional feature of the Bid Express 
service.  Contact your agency to determine if it is participating in Bid 
Tab Analysis.  
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  Exercise 4-1 

In the following exercise, you will use the Bid Tab Analysis tab to find an item’s bid 
history.  

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. If necessary, select your agency from the Select an Agency drop-down list, 
and click Go.  

6. Click the Bid Tab Analysis tab.  

7. In the  available search fields, type the desired search criteria.  

8. Select the criteria for the date range, quantity range, and price range.  

9. Click the Search button.  

10. Click the + sign for the desired item.  

11. Click the bid count for the desired proposal.  
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Downloading Plans From the Online Plan Sheets Service  

The Online Plan Sheets service provides access to a contract’s plan sheets, which can be 
accessed from any computer.  They can be viewed online, printed in the office, or ordered 
and shipped to a desired address.  The Online Plan Sheets service offers the following 
services:  

 Download all sheets in a set or select specific plan sheets 

 View plan sheets for a job in different locations 

 Pay one flat fee for viewing all plan sheets and printing them in your office 

 Access plan sheets from all participating Bid Express agencies for one flat 
fee 

 Order custom sets of printed plans in any size and have them delivered the 
office (via the Bid Express printing partners) 

The Online Plan Sheets service is accessible from the proposal page.  First, select the 
desired letting date on the Lettings tab.  Select the desired proposal.  In the Also 
Available section, click Plan Sheets to access the Online Plan Sheets service for that 
proposal.  

 

Figure 4-4.  Plan Sheets  

Open or save the plan sheets as in Adobe® Acrobat® PDF format.  The Acrobat Reader 
must be downloaded in order to view plan sheets.  

The plan sheets feature allows you to create a custom plan set by selecting one or more 
plan sheets and then clicking the Download button listed on the left hand side of the page.  
A customized plan set file (PDF document) is created based on the individual sheets you 
selected.  The resulting plan set also contains interactive bookmarks that provide 
additional information about the current letting and proposal.  
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The plan sheets can be rather large in size and may take time to download.  High speed 
Internet connections often yield the best results.  

 

Figure 4-5.  Online Plan Room 
 

The Online Plan Sheets service is an optional feature of the Bid Express 
service.  Check the list of agencies that currently use this feature before 
you add it.  This list is found in the Questions/Help section of the 
website.  

The Online Plan Sheets service allows users to view, save, and/or print 
all plans for a contract or specific plan sheets. 

  Exercise 4-2 

In the following exercise, you will view a plan sheet in the Online Plan Sheets service.  

1. Go to http://www.bidx.com.  

2. In the Email field, type your email address.  

3. In the Password field, type your password.  

4. Click the Log In button.  

5. If necessary, select your agency from the Select an Agency drop-down list, 
and click Go.  

6. Click the Lettings tab.  

7. Click the desired Letting Date link.  

8. Click the desired proposal.  

9. Click Plan Sheets in the Also Available section. 

10. Select the check boxes for the plan sheets you wish to download to create your 
own plan set. 
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11.  Click Download on left side of the page. 

12. View, save, or print the plan set. 

Navigating the Bid Express Message Center 

You can sign up to receive messages sent from one or more agencies or sent by the Bid 
Express service when the agency performs a specific action, such as adding a new letting 
or withdrawing a proposal. When the agency sends out the type of message to which you 
have subscribed, your Messages icon will display a star. You can also sign up to receive 
emails notifications. Agency administrators can see who is subscribed to receive 
messages for their agency. 

If you are using an agency-sponsored Bid Express Small Business Network account, you 
are automatically subscribed to receive message sent by the agency to its sponsored 
contractors. 

To get to My Message Center, click the Messages icon in the upper right corner. From 
there, you can add, clear, or view your notification subscriptions and file and sort your 
messages. 

Messages are sent to your inbox. From there, you can move them to different mailboxes. 

To sign up for all message types, click All under the Message column heading. To sign 
up for all emails, click All under the Email heading. 

When you subscribe to any type of notification, you are automatically signed up for the 
agency message as well. You must be signed up for agency messages in order to receive 
other notifications. 

 

Figure 4-6.  Manage Messages and Notifications 
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Figure 4-7.  Message Center Inbox 

  Exercise 4-3 

In the following exercise, you will subscribe to notifications: 

1. Click the Messages icon in the upper right corner.  

2. Click Manage Messages and Notifications.  

3. Select the agency from which you'd like to receive notifications from the 
drop down list.  

4. Select the check box for each notification you wish to receive. If you 
select Email, the Message check box is also selected. 

5. When all notification types have been selected, click SAVE.  

6. Click My Message Center in the navigation trail. 

  Exercise 4-4 

In the following exercise, you will unsubscribe to notifications: 

1. Click the Messages icon in the upper right corner. The Bid Express service 
takes you to the My Message Center inbox. 

2. Click Manage Messages and Notifications. 

3. From the drop down list, select the agency from which you'd like to 
unsubscribe your notifications. 

4. Clear the check box for the notifications you no longer wish to receive.  
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5. When you are finished, click SAVE. 

6. Click My Message Center in the navigation trail. 

Deleting Messages 

You can delete the messages from your Message Center. An email that has been deleted 
cannot be recovered. 

  Exercise 4-5 

In the following exercise, you will delete a message: 

1. Click the Messages icon if your inbox is not yet open. Select the 
appropriate mailbox from the list. 

2. Select the check box for the messages you wish to delete. 

3. Click DELETE. 

4. Click OK. 
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Using the Bid Express Small Business Network  

The Bid Express Small Business Network (SBN) facilitates the interaction between 
prime bidders and subcontractors.  It allows them to exchange sub-quotes and 
communicate about projects.  The network is especially helpful in bringing prime bidders 
and disadvantaged business enterprise (DBE) contractors together to meet specific 
agency goals.  

The prime bidder can request a sub-quote from the proposal details page on the Bid 
Express website by selecting the Create Sub-quote Request link.  This provides a step-by-
step process for requesting a sub-quote.   

 

Figure 4-8.  Request a Sub-quote Link 

When a subcontractor responds to a sub-quote request, the number of reads and replies to 
the sub-quote are updated on the Prime Contractor View page.  

Subcontractors can view requests put out by prime contractors or create their own 
unsolicited sub-quotes for items. 

For more information about the Bid Express Small Business Network, please see Section 
5. 
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Review for Section 4

To view the Bid Tab Analysis tab: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your 

email address.  
3. In the Password field, type your 

password.  
4. Click the Log In button.  
5. If necessary, select your agency 

from the Select an Agency drop-
down list, and click Go.  

6. Click the Bid Tab Analysis tab.  
7. Enter your search criteria in the 

item, description, proposal items, 
county, unit, or low bidder search 
fields.  

8. Select the desired date range, 
quantity range, and price 
range.   

9. Click the Search button.  
10. Click the + sign beneath the 

desired Item No.  
11. Click the desired Proposal Bid 

Count.  

To view a plan sheet: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your 

email address.  
3. In the Password field, type your 

password.  
4. Click the Log In button.  
5. If necessary, select your agency 

from the Select an Agency drop-
down list, and click Go.  

6. Click the Lettings tab.  
7. Click the desired Letting Date 

link.  
8. Click the desired proposal.  
9. Click the Plan Sheets link.  
10. View, save, or print the plan 

sheet. 

To create a custom plan set to download: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your email 

address.  
3. In the Password field, type your 

password.  
4. Click the Log In button.  
5. If necessary, select your agency 

from the Select an Agency drop-
down list, and click Go.  

6. Click the Lettings tab.  
7. Click the desired Letting Date 

link.  
8. Click the desired proposal.  
9. Click Plan Sheets. 
10. Select the check box for the desired 

plan sheets or click the Select All 
button.  

11. Click the Download Plan Sheets 
button.  

12. View, save, or print the plan set. 

To order an entire plan set from a print vendor: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your 

email address.  
3. In the Password field, type your 

password.  
4. Click the Log In button.  
5. If necessary, select your agency 

from the Select an Agency drop-
down list, and click Go  

6. Click the Lettings tab.  
7. Click the desired Letting Date 

link.  
8. Click the desired proposal.  
9. Click the Plan Sheets link.  
10. Click Order All. 
11. Select a print vendor and click 

Go To Order Form. 
12. Fill in the requested information 

and click Send Order. 
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To subscribe to notifications: 

1. Go to http://www.bidx.com.  
2. In the Email field, type your 

email address.  
3. In the Password field, type your 

password.  
4. Click the Log In button.  
5. If necessary, select your agency 

from the Select an Agency drop-
down list, and click Go.  

6. Click the Messages icon in the 
upper right corner.  

7. Click Manage Messages and 
Notifications.  

8. Select the agency from which 
you'd like to receive notifications 
from the drop down list.  

9. Select the check box for each 
notification you wish to receive. 
If you select Email, the Message 
check box is also selected. 

10. When all notification types have 
been selected, click SAVE.  

11. Click My Message Center in the 
navigation trail. 
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5.  Using the Bid Express Small Business Network 

By the end of this section, you will be able to: 

 Use the Bid Express Small Business Network as a Prime Contractor 

 Use the Bid Express Small Business Network as a Subcontractor 
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Bid Express Small Business Network Introduction 

The Bid Express Small Business Network (SBN) service is designed to enhance the 
communication process between small businesses - most notably DBEs - and the prime 
contracting community. 

Contractors post requests for sub-quotes for items in a selected letting.  Subcontractors 
then see the request and create a response.  After the subcontractor posts the response, the 
contractor can view it.  Subcontractors can also create unsolicited sub-quotes for items 
that were not requested by the contractor. 

The Bid Express SBN service allows subcontractors to search for sub-quote requests 
through the use of items, bid tab analysis, or specific sub-quotes. Subcontractors can 
create sub-quotes based on the proposal documents and mail or fax their sub-quotes to the 
plan holders and eligible bidders. 

 

Figure 5-1.  Bid Express Small Business Network Prime Contractor Home Page 

Bid Express SBN for Prime Contractors 

Log in to the Bid Express service and click the SMALL BUSINESS NETWORK tab.  The Bid 
Express Small Business Network service displays the Prime Contractor View.  

 Note:  If the heading reads SBN - Subcontractor View, click SBN for Prime 
Contractors in the upper right corner. 
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Figure 5-2.  Bid Express SBN Prime Contractor View 

Create a Sub-quote Request 

You can create sub-quote requests on the SMALL BUSINESS NETWORK tab.  Once you 
create your request, the Bid Express service sends an email to all subcontractors with pre-
paid account who selected the work types used in the request. 

 

Figure 5-3.  Create SBN Sub-quote Request Page 

  Exercise 5-1 

In the following exercise, you will create a sub-quote request using the Bid Express 
Small Business Network.  

1. Access the SBN tab. 

2. Make sure you are a prime contractor and click Create New. 
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 Note:  You can also get to the Create SBN Sub-quote Request page by 
selecting the letting and proposal for the sub-quote request on the 
Lettings tab. 

3. Update the header information fields with your company information if 
necessary.   

4. Enter a date for which the sub-quote request expires in the Expiration field.   

5. Enter any comments for the sub-quote request in the Comments field. 

6. If a DBE is preferred, keep the DBE Preferred check box selected. 

7. If the sub-quote request contains any other additional costs, select the check 
boxes for those costs. 

8. Click Save and Continue.   

9. Select the letting. 

10. Select the proposal. 

11. Click Add Work Types.   

12. Select the check boxes for the work types that are part of your sub-quote 
request.   

13. Click Update.   

14. Click Add Items for your first work type.   

15. Select the check boxes for the items you wish to include in your sub-quote 
request.   

16. Click Add Selected.   

17. Repeat the process until all your work types have items.   

18. Click Save and Continue.   

19. Enter any of the terms or conditions for the sub-quote request and click Save 
and Continue.   

20. Click Upload/Manage Attachments to add any attachments to your request.   

21. If you want to add any attachments, click Browse.  Navigate to and select the 
file in the Select Files window.  Click Open. 

22. Click Upload. When the attachments are uploaded, click Done.  

23. Click Save and Continue.   
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24. Review your request.  If you need to make changes, click Back at the bottom 
of the page until you reach the page that needs updating.    

25. Click Publish to publish the request and make it available to the subcontractor 
community. 

Print 

You can print a copy of your sub-quote request that includes your company name and 
contact information and all applicable letting and agency information.  Click Print.  
Make sure your printer is the one selected and click Print again. 

 Note:  If the header or footer information from your browser prints on your 
sub-quote request, turn off this feature by selecting Page Setup from the File 
menu in your browser. 

CSV 

CSV files can be saved and opened with a spreadsheet program such as Microsoft Excel.  
Click Get CSV to create a CSV file of your request.  Click Save or Open.  If you choose 
to save the file, enter a file name and click Save. 

Outreach Report 

An Outreach report helps you keep records of your effort to solicit DBE participation on 
your bids.  This report is provided as a courtesy from the Bid Express service and is not 
an official record.  Click View Outreach report to open a sample record. Use the Print 
function of your browser to print the report. Click the X in the upper right corner of the 
report when it is done printing to close the report. 

Edit and Withdraw 

If you need to make changes to your request before it is published, click Edit.  The Bid 
Express SBN service brings you to the Create Request page and you can go through the 
steps again to fix any errors. 

If you have to make changes to a published request, it must first be withdrawn.  Click 
withdraw.  When a request is withdrawn, the request information remains but is only 
visible to you.  To make your request visible to subcontractors again, click publish.  

Hide 

You can display only certain sub-quote requests on your View page by hiding ones you 
do not with to see.  Click Hide for the request on the Prime Contractor View page.  The 
Bid Express service hides the unwanted request. You cannot hide published request or 
requests that have not yet been published. If you wish to hide a published sub-quote 
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request, you must first withdraw it. You can also hide requests that are past the expiration 
date.  

View or Respond to Subcontractor Request Replies 

As a prime contractor using the Bid Express Small Business Network, you can view and 
respond to subcontractor replies. Subcontractors may respond more than once to a 
request, so while you can view all of them, you can only respond to the latest one. 

  Exercise 5-2 

In the following exercise, you will view and respond to sub-quote replies: 

1. Access the Prime Contractor View on the Small Business Network tab if you are 
not already there. 

2. Click the Reads and Replies link for the sub-quote request you wish to view. 

3. Click View Reply for the response you'd like to see.  

4. Click Respond to create a response to the sub-quote reply.  

5. If a response is already created, click View Response to see your response. 

Unsolicited Sub-quotes  

Subcontractors may create a sub-quote for items you have not requested. When they 
select you as a contractor for these quotes, the Bid Express service sends you an email 
notifying you that you have a message from the Bid Express Small Business Network and 
the quote displays in the Unsolicited Sub-quotes section of the SBN prime contractor 
view. 

  Exercise 5-3 

In the following exercise, you will respond to an unsolicited sub-quote: 

1. Access the Prime Contractor View on the Small Business Network tab if you 
are not already there. 

2. Select Respond for the unsolicited sub-quote.  

3. Enter your response in the Body field. 
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4. When you are finished, click Send. You cannot change the response once it has 
been sent. 

The Bid Express Small Business Network sends the message to the subcontractor and 
includes the message in your Sent mailbox in the message center, then returns you to the 
Prime Contractor View. In addition, the Respond link changes to View Response. 

Bid Express SBN for Subcontractors 

As a subcontractor using the Bid Express Small Business Network, you can respond to 
sub-quote requests. You can also create an unsolicited sub-quote and send it to prime 
contractors. 

To access the Bid Express SBN for subcontractors, click the SBN tab. If the heading says 
Prime Contractor View, click the SBN for Subcontractors link in the upper right corner. 

Sponsored accounts provided by the DOT allow you to select work types from the agency 
and will be notified when a sub-quote request is submitted that contains that work type. 

View Published Sub-quote Requests 

You can view sub-quote requests in the Bid Express Small Business Network after a 
prime contractor publishes them.  

Click View Sub-quote Request in the Sub-quote Request column for the request you wish 
to view.  The Bid Express service displays a read-only view of the request.  You can click 
the Letting ID, Letting Date, or Proposal to go to the details page. The request also shows 
the date it was created and last updated, as well as withdrawn or published. 

If you have not yet responded to this request, click reply to go to the Reply to Request 
page. Click edit reply if you have a reply draft. 

When you are done viewing the sub-quote request, click cancel or SBN Landing Page in 
the navigation trail to return to the SBN Subcontractor View, or click reply to go to the 
Create Sub-quote Request page. 

Create or Edit a Sub-quote Request Reply 

You can reply to contractor's sub-quote requests in the Bid Express Small Business 
Network. In the Subcontractor View of the SBN tab, click Reply for the request. The Bid 
Express service goes to the Reply to SBN Sub-quote Request page.   

You have the option of downloading a CSV file of the request to enter the response in a 
spreadsheet program, or you can enter it in the Bid Express Small Business network.  
Once you click Notify at the end, you cannot change or withdraw your response. Click 
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Cancel to return to the list of sub-quote requests without notifying the contractor. You 
can also make edits to your draft at a later time if you do not notify the contractor.  

You can modify your request as often as you like until the request has expired. The 
contractor will be able to see every request, but can only respond to the final one. 

  Exercise 5-4 

In the following exercise, you will reply to a sub-quote request using the Bid Express 
SBN service: 

1. Go to the Bid Express Small Business Network and select Reply for the request to 
which you are responding.   

2. Verify the header information in the fields. 

3. Click in the Expiration field to open a calendar.  Navigate to and select the date 
for how long this request is valid.  

4. Select any additional costs to be included in the quote. 

5. Click Save and Continue.  

6. Select the check boxes of the items to add to your response.  

7. Add your price for each item. If necessary, change the quantities and add any 
comments. 

8. Click Save and Continue.  

9. Enter any terms or conditions regarding the sub-quote in the available space.  

10. Click Save and Continue.  

11. Click Upload/Manage attachments to add any attachments to your quote.  Click 
Browse.  Navigate to and select the file in the Select Files window.  Click Open. 

12. When you are finished adding attachments, click Upload.  

13. Click Save and Continue.  

14. Review your quote. If you need to make changes, click Back at the bottom of the 
page until you reach the page that needs updating.    

15. Click Notify to send your response to the contractor.  
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CSV File 

You can download a CSV file of the request information, enter your values in a 
spreadsheet program, and then upload your file back to the Bid Express Small Business 
Network. 

  Exercise 5-5 

In the following exercise, you will download the CSV file: 

1. Go to the Bid Express Small Business Network and select the request to which 
you are responding.   

2. Click Download Request CSV. 

3. Open or save the file. 

4. Enter your values for the requested items.  Include any comments if necessary. 

5. Delete any work types or items to which you are not responding.  

6. Save the file. 

  Exercise 5-6 

In the following exercise, you will upload the completed CSV file: 

1. Go to the Bid Express Small Business Network and select the request to which 
you are responding.   

2. Click Browse next to the Upload CSV field.   

3. Navigate to and select the CSV file containing your response. 

4. Click Open. 

5. Click Save and Continue. 

To finish your sub-quote response, continue following the instructions at Step 9 in the 
Reply to Sub-quote Request section. 

Edit your Sub-quote Request Response 

You can edit your sub-quote request response provided you did not send the contractor 
notification. 
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Go to the Bid Express Small Business Network and select Edit Draft for the request to 
which you are responding.  The Bid Express services goes to the Reply to SBN Sub-
quote Request page. 

Use the Save and Continue button to access the pages that need changing. 

Change the reply by highlighting the incorrect information and entering in the new 
values. 

When you are finished, click Notify to send your response to the contractor. Once you 
click notify, you cannot change or withdraw your response. Click Cancel to return to the 
list of sub-quote requests without notifying the contractor.  

Create or Edit Unsolicited Sub-quote Requests 

As a subcontractor, you can create sub-quotes for items in any proposal and send it to 
selected contractors. You can edit a request provided you have not yet sent it to a 
contractor. 

Once your quote has been completed, you can save it or send it to vendors.  If you send it 
to vendors, the Bid Express service notifies the selected contractors they have an 
unsolicited sub-quote. 

  Exercise 5-7 

In the following exercise, you will create an unsolicited sub-quote: 

1. On the Small Business Network tab in the subcontractor 
view, click Create New next to the Unsolicited Sub-quote 
Table heading.  

2. Verify the header information in the fields. 

3. Click in the Expiration field to open a calendar.  Navigate 
to and select the date for how long this request is valid.  

4. Select any additional costs to be included in the quote. 

5. Enter any comments in the Comments field. 

6. Click Save and Continue.  

7. Click Select this letting. 

8. Select the proposal for which you are creating the sub-
quote.  
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9. Click Add Work Types. 

10. Select the check box for the work types used in the sub-
quote.  

11. Once all the work types are selected, click Add Selected. 

12. Add items to your work type by selecting Add Items.   

13. Select the check boxes of the items to add to the work type.  

14. Once all the items are selected, click Add Selected. 

15. Add the price to your quote for each item. You can also 
change the quantities and add any comments. 

16. Repeat the steps for adding items for your remaining work 
types.  

17. Click Save and Continue.  

18. Enter any terms or conditions regarding the sub-quote in 
the available space.  

19. Click Save and Continue.  

20. Click Upload/Manage attachments to add any 
attachments to your quote.   

21. If you want to add any attachments, click Browse.  
Navigate to and select the file in the Select Files window.  
Click Open. 

22. Add more files by clicking browse and selecting the file. 
When you are finished, click Upload. When the 
attachments are uploaded, click Done.   

23. Click Save and Continue.  

24. Review your quote.  If you need to make changes, click 
Back at the bottom of the page until you reach the page 
that needs updating.    
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  Exercise 5-8 

In the following exercise, you will send your unsolicited sub-quote to the vendors. 

1. Select your quote in the Unsolicited Sub-quote column. 
Click Choose Vendors. 

2. Click Add Vendors. 

3. Select the check boxes of the vendors to which you want to 
send the sub-quote.  

4. When you are finished, click Add Selected. 

5. Click Notify to send your quote to the selected vendors. 

Editing the Unsolicited Sub-quote 

If you have not yet notified the contractor about your sub-quote, you can make changes to 
it.  If you do not see the Edit link for your sub-quote, it cannot be modified. 

  Exercise 5-9 

In the following exercise, you will edit an unsolicited sub-quote that has not yet been sent 
to vendors: 

1. In the subcontractor view of the SBN tab, click Edit for the 
unsolicited sub-quote you wish to change.  

2. Correct any incorrect information by going through the 
sub-quote using the Save and Continue button until you 
reach the end.  

3. There you can choose your contractors or click Cancel to 
return to the subcontractor view. 
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Review for Section 5
 
To create a sub-quote request using the Bid 
Express Small Business Network.  

1. Access the SBN tab. 
2. Make sure you are a prime contractor and 

click Create New. 
3. Update the header information fields with 

your company information if necessary.   
4. Enter a date for which the sub-quote 

request expires in the Expiration field.   
5. Enter any comments for the sub-quote 

request in the Comments field. 
6. If a DBE is preferred, keep the DBE 

Preferred check box selected. 
7. If the sub-quote request contains any other 

additional costs, select the check boxes 
for those costs. 

8. Click Save and Continue.   
9. Select the letting. 
10. Select the proposal. 
11. Click Add Work Types.   
12. Select the check boxes for the work types 

that are part of your sub-quote request.   
13. Click Update.   
14. Click Add Items for your first work type.   
15. Select the check boxes for the items you 

wish to include in your sub-quote request.   
16. Click Add Selected.   
17. Repeat the process until all your work 

types have items.   
18. Click Save and Continue.   
19. Enter any of the terms or conditions for 

the sub-quote request and click Save and 
Continue.   

20. Click Upload/Manage Attachments to 
add any attachments to your request.   

21. If you want to add any attachments, click 
Browse.  Navigate to and select the file in 
the Select Files window.  Click Open. 

22. Click Upload. When the attachments are 
uploaded, click Done.  

23. Click Save and Continue.   
24. Review your request.  If you need to make 

changes, click Back at the bottom of the 
page until you reach the page that needs 
updating.    

25. Click Publish to publish the request and 
make it available to the subcontractor 
community. 

 

To view and respond to sub-quote replies: 

1. Access the Prime Contractor View on the 
Small Business Network tab if you are not 
already there. 

2. Click the Reads and Replies link. 
3. Click View Reply for the response you'd 

like to see.  
4. Click Respond to create a response to the 

sub-quote reply.  
5. If a response is already created, click 

View Response to see your response. 
6. In the following exercise, you will 

respond to an unsolicited sub-quote: 
7. Access the Prime Contractor View on 

the Small Business Network tab if you are 
not already there. 

8. Select Respond for the unsolicited sub-
quote.  

9. Enter your response in the Body field. 
10. When you are finished, click Send. You 

cannot change the response once it has 
been sent. 

 

To reply to a sub-quote request using the Bid 
Express SBN service: 

1. Go to the Bid Express Small Business 
Network and select Reply for the request 
to which you are responding.   

2. Verify the header information in the 
fields. 

3. Click in the Expiration field to open a 
calendar.  Navigate to and select the date 
for how long this request is valid.  

4. Select any additional costs to be included 
in the quote. 

5. Click Save and Continue.  
6. Select the check boxes of the items to add 

to your response.  
7. Add your price for each item. If 

necessary, change the quantities and add 
any comments. 

8. Click Save and Continue.  
9. Enter any terms or conditions regarding 

the sub-quote in the available space.  
10. Click Save and Continue.  
11. Click Upload/Manage attachments to 

add any attachments to your quote.  Click 
Browse.  Navigate to and select the file in 
the Select Files window.  Click Open. 
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12. When you are finished adding 
attachments, click Upload.  

13. Click Save and Continue.  
14. Review your quote. If you need to make 

changes, click Back at the bottom of the 
page until you reach the page that needs 
updating.    

15. Click Notify to send your response to the 
contractor.  

 

To download the CSV file: 

1. Go to the Bid Express Small Business 
Network and select the request to which 
you are responding.   

2. Click Download Request CSV. 
3. Open or save the file. 
4. Enter your values for the requested items.  

Include any comments if necessary. 
5. Delete any work types or items to which 

you are not responding.  
6. Save the file. 
 
To upload the completed CSV file: 

1. Go to the Bid Express Small Business 
Network and select the request to which 
you are responding.   

2. Click Browse next to the Upload CSV 
field.   

3. Navigate to and select the CSV file 
containing your response. 

4. Click Open. 
5. Click Save and Continue. 
 

To create an unsolicited sub-quote: 

1. On the Small Business Network tab in the 
subcontractor view, click Create New 
next to the Unsolicited Sub-quote Table 
heading.  

2. Verify the header information in the 
fields. 

3. Click in the Expiration field to open a 
calendar.  Navigate to and select the date 
for how long this request is valid.  

4. Select any additional costs to be included 
in the quote. 

5. Enter any comments in the Comments 
field. 

6. Click Save and Continue.  
7. Click Select this letting. 
8. Select the proposal for which you are 

creating the sub-quote.  
9. Click Add Work Types. 

10. Select the check box for the work types 
used in the sub-quote.  

11. Once all the work types are selected, click 
Add Selected. 

12. Add items to your work type by selecting 
Add Items.   

13. Select the check boxes of the items to add 
to the work type.  

14. Once all the items are selected, click Add 
Selected. 

15. Add the price to your quote for each item. 
You can also change the quantities and 
add any comments. 

16. Repeat the steps for adding items for your 
remaining work types.  

17. Click Save and Continue.  
18. Enter any terms or conditions regarding 

the sub-quote in the available space.  
19. Click Save and Continue.  
20. Click Upload/Manage attachments to 

add any attachments to your quote.   
21. If you want to add any attachments, click 

Browse.  Navigate to and select the file in 
the Select Files window.  Click Open. 

22. Add more files by clicking browse and 
selecting the file. When you are finished, 
click Upload. When the attachments are 
uploaded, click Done.   

23. Click Save and Continue.  
24. Review your quote.  If you need to make 

changes, click Back at the bottom of the 
page until you reach the page that needs 
updating.    
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To send your unsolicited sub-quote to the 
vendors. 

1. Select your quote in the Unsolicited Sub-
quote column. Click Choose Vendors. 

2. Click Add Vendors. 
3. Select the check boxes of the vendors to 

which you want to send the sub-quote.  
4. When you are finished, click Add 

Selected. 
5. Click Notify to send your quote to the 

selected vendors. 
6. In the following exercise, you will edit an 

unsolicited sub-quote that has not yet been 
sent to vendors: 

7. In the subcontractor view of the SBN tab, 
click Edit for the unsolicited sub-quote 
you wish to change.  

8. Correct any incorrect information by 
going through the sub-quote using the 
Save and Continue button until you 
reach the end.  

9. There you can choose your contractors or 
click Cancel to return to the subcontractor 
view. 

 

 
 



 

5-16 Using the Bid Express Small Business Network 

 


	Bid Express Service Training Manual - Student
	Contents
	1. Getting Started With the Bid Express Service
	Using the Bid Express Service Training Manual
	Understanding the Bid Express Service
	Subscribing to the Bid Express Service
	Navigating the Bid Express Home Page
	Viewing the Agency Home Page
	Navigating the My Bidx Page
	Viewing the Lettings Tab
	Viewing a Contract
	Performing a Search
	Accessing Help, FAQs, and Customer Support
	Review for Section 1

	2. Managing a Digital ID
	Understanding the Purpose of the Digital ID
	Downloading the Expedite Bid Software
	Configuring the Expedite Bid Software
	Creating a Digital ID for Bidding With a State or Local Agency
	Checking the Status of Your Digital ID
	Exporting and Importing a Digital ID
	Review for Section 2

	3. Submitting Bids Via the Internet
	Understanding the Process of Submitting Bids Over the Internet
	Downloading the Proposal
	Opening the Proposal in the Expedite Bid Program
	Preparing a Bid
	Verifying a Bid is Complete
	Submitting a Bid
	Withdrawing a Bid
	Review for Section 3

	4. Understanding Additional Bid Express Services
	Analyzing Bids With the Bid Tab Analysis Service
	Downloading Plans From the Online Plan Sheets Service
	Navigating the Bid Express Message Center
	Using the Bid Express Small Business Network
	Review for Section 4

	5. Using the Bid Express Small Business Network
	Bid Express Small Business Network Introduction
	Bid Express SBN for Prime Contractors
	Bid Express SBN for Subcontractors
	Review for Section 5


